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Information in this document is subject to change without notice. 
Therefore, no claims are made as to the accuracy or completeness of this document.

Galaxy Control Systems makes no claims on the requirements or limitations of software or devices of 3rd Party
Manufacturers. Every effort is made to include all known requirements and capabilities as they relate to System
Galaxy. Information herein may not supersede requirements of 3rd party manufacturers

No part of this document may be reproduced, copied, adapted, or transmitted, in any form or by any means, elec-
tronic or mechanical, for any purpose, without the express written consent of Galaxy Control Systems.  Copyright
protection claims include all forms and matters of copyrighted material and information, including but not limited
to, material generated from the software programs, which are displayed on the screen such as icons, look and
feel, etc.

5th Edition / SEPT 2024 Copyright © 2022 w Galaxy Control Systems w All rights reserved

Release with ver. 11.X
Trademarks
As applicable, the following names, logos, and trademarks are intellectual and registered property of their respect-
ive owners in the United States of America and other jurisdictions worldwide. 

Screenshots used in this guide are for instructional reference only. Concept and Topology diagrams are original
design of illustrator unless otherwise indicated.

Scope
This guide covers known requirements and instructions to configure System Galaxy to integrate with 3rd Party
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Galaxy Control Systems
3 North Main Street

Walkersville MD 21793

www.galaxysys.com

Video Plug-ins. 

Manufacturer's Specific Requirements and Compatibility
Always consult the manufacturer’s documentation for requirements and capabilities related to the product ( i.e.
OS, install/set up, speed, bandwidths, supported camera models and features, codecs, etc. ). The availability of
features, cameras, video controls etc. are controlled by the 3rd Party Plug-ins and may change without notice.
Contact authorized Tech Support if questions arise.

History
SG 11.7.0 (3rd Edition) – Merge all VPIs into one guide.
SG 11.8.3 (5th Edition) – Pub all guides seperately by brand from Flare.
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Introduction to Milestone XP Video Plugin
These instructions apply to the Milestone XP Video Plugin that integrates with System Galaxy.

FEATURED TOPICS
Perform these topics in sequential order - i.e., setup, install, and configure for your brand video system.

l Setup & Requirements Checklist

l Install Video Plugin

l Configure Cameras

l View Video

You must meet Requirements and Setup Checklist before installing Video Plugin files.

System Overview
The diagram below depicts the System Galaxy integration with a Video Management System using the Web API Inter-
face and Video Plugins which are installed on the System Galaxy workstation.

System Settings

After the DVR Support is enabled in the System Registration, certain options must be configured in the Sys-
tem Settings to allow video viewing at each workstation - or control how system alarms affect video play-
back. See Requirements & Setup for details.
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DVR Enabled
The DVR Enabled option controls whether the Galaxy Video Viewer can be opened and play video. This is a
workstation-specific option, so you can disable this at clients where you don’t need video monitoring.

Auto Pop On Alarm
The Auto-Pop or Callup Video on Alarm controls whether the Video Viewer will automatically open and play
live video when an alarm is detected from a door or input that is linked to a camera.

Note: the Alarm Priority and time of alarm can affect which camera feed is displaying when
multiple alarms are triggered. Generally the newest alarm takes precedence unless an alarm pri-
ority overrides it. Test your incoming video vigorously to be sure you understand how your
alarm options affect video.

Installing Plugins

You should complete all the system programming and camera programming including camera names at
the Video Management Unit before you install the Video Plugins. This includes configuring the SG Login
account at the VMS and give it permissions to all cameras. Once this is done you can proceed to the
Installing Video Plugin topic for your brand of VMS. The GCS Web API Service must be running /online
before you install the Plugin file.

Linking Cameras

Cameras are linked to doors, elevators, or inputs (such as motion detectors) from within the System Galaxy
software programming screens.

Viewing Video

After cameras are linked in the System Galaxy programming, the SG Operator to call live video from any
linked door/input/elevator that is visible in the Hardware Tree or Graphics Screen by using the Operator
Command Menu. SG Operators can also call video from System Alarm Screen or Activity Events Report .

SIDE NOTE: System Galaxy still supports the traditional DVR interface which does not use Web API
Plugins. The dealer would simply install the DVR/NVR using the traditional method in the DVR Pro-
gramming screen as described in the traditional Galaxy DVR/NVR Integration Guide. New systems
are recommended to use the new Web API Video solution.

http://www.galaxysys.com/sghelp/_docs/currdocs/SG-DVR-NVR-VMS_Generic.pdf
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Part 1: Requirements & Setup
This topic covers the Requirements and Setup that must be done before you install any Video API Plugin. 

FEATURED TOPICS

l Video Plugin Requirements
l SG Setup Checklist (required for all VPI brands)

Video Plugin Requirements
1. System Galaxy (SG) must be correctly installed and working before you install the Video Plug-In files.

l To obtain the Galaxy Installation media with the Auxiliary folder intact see the Download Soft-
ware page where you can either download the ISO files or order a USB Thumbdrive from Cus-
tomer Service.

If GCS Services are running on a Server OS, you must install and operate Video Plugin
files on a client workstation with Windows 10 to support monitoring and video view-
ing.

See the Galaxy Installation Worksheet for quick steps to install System Galaxy.

See the SG Install Checklist in this guide for steps to register and enable Video View-
ing.

2. Your Video Management System (VMS/NVR unit) must be fully installed and working properly.
l You need administrative rights on the VMS Unit to create a user login for the SG clients.
l In some brands of VMS, the user login may need to have permissions to all the cameras.

Download Software.htm
Download Software.htm
http://www.galaxysys.com/sghelp/_docs/currdocs/QRS-QRG/SG-SystemInstallProcedure.pdf
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SG Setup Checklist (required)
This checklist validates the SG programming options are set correctly that relate to video support.

1. ___ Verify System Registration is correct: Configure > Options > Registration > System
l Product level must be “Corporate” or “Enterprise” (per the purchase agreement).

l ‘3rd Party DVRs’ optionmust be enabled (checked) if your VMS is not an OEM Video Plugin.

l ‘Units’ fieldmust have the correct number of maximum units (per purchase agreement).

2. ___ Verify Client Web APIis enabled at each workstation that needs video support:
Configure > Options >  Client Gateway…
l ‘Use Web Services’ checkbox option must be “checked”.

l ‘Web Service URL’ must include the correct port number - 8000 (default) or 8443 (SSL Cert).

See the Galaxy IT Network Checklist for ports that must be available/unblocked.

3. ___ Verify you can connect to the Web API Swagger page from the SG communication server and from
each client workstation, using:  http://X.X.X.X:8000/swagger   or   https://X.X.X.X:8443/swagger. 

4. ___ Verify the following System Settings are correct at each/every client workstation that needs video
support:
Configure > Options > System Settings…

l General tab: ‘DVR Enabled’ optionmust be “checked” to support the Video Viewer.
l General tab: ‘Does Not Support Monitoring’ optionmust be “unchecked” to support ability to
manually launch the Video Viewing from an alarm event (in Alarm Event screen).

l Alarm Options tab: ‘Automatically Call-Up Video’ optionmust be “checked” if you want the Video
Viewer to automatically launch when an alarm event happens at door or input. (Note: that if mul-
tiple camera feeds are activated, the Viewer will display the video feed from the last event, or from
the highest priority event if other alarm priority programming options are configured. Testing your
set-up is highly recommended.)

5. ___ Verify that SG Alarm screen pops open when an alarm condition occurs at an armed device, and
that the screen is displaying the alarm events for the hardware that you will be linking cameras to.

See the Hardware Programming sections in SG User Guide for configuring readers
and inputs for alarm events such as Door Forced Open or Armed Alarm.

http://www.galaxysys.com/sghelp/_docs/currdocs/IT-CheckList.pdf
http://www.galaxysys.com/sghelp/_docs/currdocs/SG-SoftwareUserGuide.pdf
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6. ___ Restart System Galaxy if you changed any of the settings. This will ensure System Galaxy is ini-
tialized.

NEXT: See PART-2 Installing Plugins for information about installing the Video Plu-
gin Files.
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Install Milestone XProtect Plugin
This topic covers installing a Video API Plugin for Milestone XProtect 64bit Video Management System (VMS).
Instructions include installing the Middleware Service, the VMS unit login credentials, connecting to the VMS, and
importing the camera names.

FEATURED TOPICS
l Install Milestone XP Plugin (Server)
l Install Milestone XP Middleware (Server)
l Install Video Plugin File (Client)
l Connect to VMS and Import Cameras
l Test VMS and Cameras

Milestone XProtect Video Plugin (Server)
This step describes installing the Video Plugin file on the computer that hosts the Galaxy GCS Services.

PREREQUISITES
l Verify GCS Web API Service is running:

Test URL > http://localhost:8000/swagger   or   https://X.X.X.X:8334/swagger (SSL)

l TheMilestoneXprotect.exe plugin install file is under the Auxiliary folder on the Galaxy Install media
(USB/ISO).
Path > USB:\\Auxiliary\System Galaxy\Video Plugins\MilestoneXprotect
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STEPS

1. Copy theMilestoneXP.exe file into theMilestone XP Folder on the Galaxy Services Computer.
NOTE: you must create the Milestone XP folder if it does not exist.

Your PC > C: \\GCS\System Galaxy\Video Plugins\MilestoneXprotect

2. Right-click on theMilestoneXprotect .exe file and choose ‘Run as Administrator’ from the menu.
The plug-in exe should self-extract.

Extracting Video Plugin file

Install Middleware Connector Service
This step covers installing theMiddleware Connector Service on the computer that hosts the GCS Services. 

PREREQUISITES
l TheMiddleware Connector Service must be installed on the same computer that is hosting the GCS Services.

l Galaxy’s GCS Web API Service must be running, or the Middleware Connector will not install.  
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STEPS
1. Browse to the SGMilestone x64 MiddleWare Installer (.EXE file) on the computer running GCS ser-

vices.

C:\\GCS\System Galaxy\Video Plugins\MilestoneXprotect\Installers\SG_Milestone_x64_MiddleWare_
Installer.exe

2. Right-click the Middleware Installer EXE file and choose to ‘Run as Administrator’.

3. The Installer program will open, clickNEXT to begin.

4. You can accept default temp folder location (desktop).

NOTE: The installer will remove the temp folder after it finishes installing.

5. Click Install button (see figure below).

Installing the Milestone Middleware

6. Click FINISH when you are done.

7. Open the PC Services window, verify the status of the ‘Milestone Xprotect Connector Service’ is “Run-
ning” and is configured to “Automatic” startup.

Milestone service status is Running/Automatic
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Install Video Plugin (Client)
This step covers installing the video plugin file on a Galaxy client workstation.

You can skip this step if you do not need Video at a client workstation.

PREREQUISITES
l The GCSWeb API Service must be running.

l The GCS Services Computer must be online.

l The options that are related to Video Viewing and Monitoring must be enabled at this client. Refer to the Setup Check-
list Item-4 in for details. 

STEPS

1. Copy theMilestoneXP.exe file into theMilestone XP Folder on the Galaxy Services Computer.
NOTE: you must create the Milestone XP folder if it does not exist.

Your PC > C: \\GCS\System Galaxy\Video Plugins\MilestoneXprotect

2. Right-click on theMilestoneXprotect .exe file and choose ‘Run as Administrator’ from the menu.
The plug-in exe should self-extract.

Extracting Video Plugin file
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Connect to VMS & Import Cameras
This step describes adding a VMS Unit and client login to Galaxy, and importing the camera names.

PREREQUISITES
l The VMS Unit must already be installed, configured and online.

l The VMS Client Login for Galaxy must already be created at the VMS Unit and must have the correct per-
missions to view all cameras.

l All camera names must be configured at the VMS unit before you add the VMS to System Galaxy.

l The GCS Web API Service and theMilestoneXprotect Connector Service must be running.

l You must know the IP Address of the VMS Unit (or web address if hosted over the internet)

l You must know the VMS’s client login credentials (Username/Password).

IMPORTANT: Camera names cannot be changed in System Galaxy. Camera names must be con-
figured at the VMS Unit before they are imported into System Galaxy when the VPI Programming is
done (this step). The imported names will display in screens and reports throughout System Galaxy,
including the SG Hardware Tree, Reader Programming Screen, Input Programming Screen, and the GCS
VPI Video Viewer. TIP: Create camera names that are useful - like what area it shows - e.g., lobby
mezzanine, east parking lot, employee entrance, elevator lobby cam1.
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STEPS
v Open the Plugin Screen - Configure > Hardware > DVR’s > Video Plugins

1. In the Plugins window, select “MilestoneXprotect” and clickOK to open the VMS Programming Screen.

2. Enter a unique and meaningful Name (i.e. “MilestoneXP 01”). 

FYI: This name is displayed throughout the screens and reports in System Galaxy - such as
Hardware Tree, DVR Properties, Camera Programming, or Reader & Input screens, etc.

3. Enter Client Login Credentials (User or Domain & Password). Login rights must allow view-
ing/controlling cameras. 

4. Enter the Web Services URL of the VMS unit (port number is not needed).

5. Click the [TEST] and [SAVE CONNECTION] buttons, which will test the connect and import the camera
names.

6. Click [SAVE SYSTEM DATA] button, to save VMS connection settings and camera names into the SG
database.

IMPORTANT: You must restart System Galaxy software after saving data to initialize the VPI
system configuration.

VMS Programming & Camera Import - DEFAULT PORT = NONE
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The fields available may vary for your brand of Video Plugin.

Test the VMS & Cameras
This step verifies that the VMS Unit and cameras were added correctly and that you can play video from chosen cam-
eras.

PREREQUISITE
l You must have completed the previous section by saving your System Data and restarting System
Galaxy.

STEPS

Launch System Galaxy and sign-in if you have not already done so. The Hardware Tree should
be open.

TIP: You can refresh the Hardware Tree from the View menu.
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1. Click the DVRs icon (+ ) to see the list of VMS Units.

RESULT > you should see the VMS Name that you created in the previous step.

2. Click on your VMS Name (+ ) to see the list of cameras imported.

NOTE: If you did not create custom camera names in the VMS Unit before you imported, then you
will see the default camera names from the VMS – such as Camera 1, Camera 2, (…), a serial
number, or whatever the default naming scheme of your VMS unit.

Do not change cameras in Galaxy after the import is done. Camera
names in Galaxy must exactly match the camera names in the VMS
Unit. You must create custom or specified camera names in the
DVR/VMS Unit before you do the camera import step.

VMS Unit & Cameras listed in the SG Hardware Tree

3. Right-click a Camera icon and select ‘View Live Video’ from the menu.

RESULT > the Video Viewer plays live video from the chosen camera. (Test every camera)

4. When you have tested all your cameras, you can link the cameras to the SG hardware ( readers &
inputs ).

See Part-3 Configure Cameras to link cameras to readers or inputs.
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See the Hardware Programming sections in SG User Guide for assigning cam-
eras to readers and inputs as well as configuring them to respond to alarm con-
ditions such as “Door Forced Open” or “Armed Alarm”.

.

http://www.galaxysys.com/sghelp/_docs/currdocs/SG-SoftwareUserGuide.pdf
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Part 3:  Linking Cameras
This topic describes how to link a camera to Doors or Inputs in the System Galaxy programming screens.

Features in this Topic

l Linking Camera to Reader
l Linking Camera to Input
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Link Camera to a Reader
This section describes how to link a camera to a Door/Reader.

PREREQUISITES
l The GCSWeb API Service must be running.
l The VMS Unit and Cameras must already be installed /imported into System Galaxy (including camera names).
l Video Viewing: DVR Enabled checkbox must be “checked” (System Settings > General).
l Video Viewing: Does Not Support Monitoring checkbox must be “unchecked” (System Settings > General).
l Auto-Call Video: Auto-Callup Video on Alarm checkbox must be “checked” (System Settings > Alarm
Options).

v Open Reader screen - Configure > Hardware > Doors

1. Click the EDIT button and select the 'DVR Camera Settings' tab.
2. Select the VMS Unit name (droplist).
3. Select the desired Camera name (droplist).

NOTICE: If you want to automatically call-up video on door alarm events, you must con-
figure the Door/Reader hardware to respond to alarms by setting hardware to be
acknowledged by the operator.

See Reader Programming in the Hardware Programming Chapter of the SG User Guide for
information about configuring the system to generate alarm events for alarm conditions
such as “Door Forced Open” or “Door Open Too Long”, etc.

5. Click APPLY to save the settings when finished.

Camera Settings (Reader/Door Property screen)

http://www.galaxysys.com/sghelp/_docs/currdocs/SG-SoftwareUserGuide.pdf


Page 21 of 26



Page 22 of 26

Linking a Camera to an Input
This section describes how to link a camera to an Input device such as a motion detector.

PREREQUISITES
l The GCSWeb API Service must be running.
l The VMS Unit and Cameras must already be installed /imported into System Galaxy (including camera names).
l Video Viewing: DVR Enabled checkbox must be “checked” (System Settings > General).
l Video Viewing: Does Not Support Monitoring checkbox must be “unchecked” (System Settings > General).
l Auto-Call Video: Auto-Callup Video on Alarm checkbox must be “checked” (System Settings > Alarm
Options).

v Open Input screen - Configure > Hardware > Inputs

1. Click the EDIT button and select the 'DVR Camera Settings' tab.

2. Select the VMS Unit name (droplist).
3. Select the desired Camera name (droplist).

NOTICE: If you want to automatically call-up video on door alarm events, you must con-
figure the Door/Reader hardware to respond to alarms by setting hardware to be
acknowledged by the operator.

See Input Programming in the Hardware Programming Chapter of the SG User Guide for
information about configuring the system to generate alarm events for armed inputs.

5. Click APPLY to save the settings when you are finished.

Camera Settings (Input Property screen)

http://www.galaxysys.com/sghelp/_docs/currdocs/SG-SoftwareUserGuide.pdf
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Part 4: View Video
This topic covers the general operation of the Video Viewer in live and recorded modes. 

Features in this Topic

l About Playback Controls

l Operate Viewer in Live Mode

l Operate Viewer In Recorded Mode

Playback Controls

The availability of playback controls and viewing modesmay vary based on the type of camera connected or the per-
missions configured at the VMS Unit.

l If a camera does not support a particular feature (e.g. ptz), then it will not be available in the Video Viewer. 

l The client login account at the VMS Unit must have the proper permissions to operate cameras and see video. 

l See the Manufacturer’s Documentation for instructions on programming the VMS Unit.
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Operate Viewer in Live Mode

LIVE MODE = Select Live tab

1. Live Video Frame displays when operator chooses View Video from an alarm event or hardware icon.

2. Double-click a camera to start playing live video from the camera; (a checkmark appears beside cam-
era).

3. Grid View checkbox - toggles the video frame between normal view and grid view. 
l CHECKED = Changes the video frame to a 2x2 grid and enables viewing of multiple cameras
(up to 4 cameras at once). Double-clicking a camera starts its video in the next frame. 

l UNCHECK = Returns video frame to single camera view.  Streams live video of selected camera.

4. PTZ Controls - drive the PTZ camera in a desired direction (pan/tilt =3456) (zoom = +/-)

5. Continuous Operation checkbox – toggles the PTZ Mode between continuous sweep and incremental
steps.

l CHECKED = Continuous Sweep. PTZ Camera will sweep in the direction you drive it.
(click3456)Camera pans to the end of its range with one click.

l UNCHECK = Incremental Steps. PTZ Camera moves small steps in the direction you drive it.
(click3456) Camera pans step-by-step with each click.   

Video Viewer – Live Mode
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Operate Viewer in Recorded Mode

RECORDED MODE = Select Playback tab

1. Playback Video Frame displays when operator chooses View Video from a historical event in DVR View
screen. The DVR View screen opens from the Activity History Report window if ‘DVR View’ is checked
when you generate report.

2. Double-click a camera to choose it (a checkmark should appear beside the camera). You need to enter
a date/time to start playing video from that point.

3. Date/Time field Choose a date and time to start the video. This will be the start time of the video you
play back.

4. Playback Controls – lets operator control direction and speed of the video. 
l Play = starts playing video at the indicated speed.
l Pause = stops/freezes video playback
l Skip Forward/Reverse = skips forward/reverse in the direction you choose and plays video from
that point.

l Speed = sets the playback speed at 1, 2, 3,  to 4 times normal rate of playback. “1” is the normal
playback speed.

5. Playback Timer – show/hide playback clock. This clock starts from date/time selected (helpful if VMS or
camera clock times are not synced or not displayed (configurable at the VMS unit). 

l CHECKED = shows the playback clock timer. 
l UNCHECKED = hides the playback clock timer.

Video Viewer – Recorded Mode
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